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FOREWORD

Thank you,
For choosing museum pro.

museum pro offers you a comprehensive and innovative tool for virtual ex-
hibition planning that simplifies complex and conceptual processes.

This manual will introduce you to the basics of our software and familiarise
you with the features of museum pro.

Further information and video tutorials can be found online at:
https://help.cura3D.com

Enjoy planning your exhibition
with museum pro - your cura® Team.

www.cura3D.com
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HARDWARE REQUIREMENTS

Minimum requirement Recommended

Intel i5 with 2.7 GHz or comparable Intel i7 with >2.5 GHz or comparable
8GB RAM 16 GB RAM
. . NVIDIA Geforce GTX 1080 graphics card*
I Intel Iris XE with at least 6GB VRAM or better

an
. Mouse with 2 buttons Mouse with 3 buttons
== Windows 7 or 8 Windows 10 or 11

’
S Mac OS 10.13 (High Sierra) Mac S 10.15 (Catalina)

i
@ Mac OS 11 (Big Sur) Mac OS 13 (Ventura)

*We recommend using a graphics card with 2000 Passmark G3D Mark points or more.

You can find your graphics card at the following link and display the performance values: https://www.vi-
deocardbenchmark.net/gpu_list.php

www.cura3D.com
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LICENSING

License Models

We offer two licence models for our software museum pro:
Single user licence

The single user licence is purchased for a single computer.

This licence is hardware-bound and can only be used on this one computer
after a short online activation.

Floating licence

The floating licence can be installed on multiple computers. The number of
concurrent users is equal to the number of licences purchased. If the li-
cence(s) is/are activated on an additional computer(s), you will receive a
message that no licence is available and that the program will now be termi-
nated.

If you are unable to connect to our licensing server, you will receive a mes-
sage stating that it is not possible to connect to our licensing server. In this
case, check your internet connection or if you are using a proxy to connect
totheinternet

www.cura3D.com
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INSTALLATION
WINDOWS

Installation instructions for Windows

Please ensure that your Windows PC meets the minimum hardware requi-
rements!

Before starting the installation, please log on as administrator and close all
running applications if possible.

www.cura3D.com

Double click on "cura3Dmuseumpro_setup.exe".
The installation screen of the software will appear.

Read the software licence agreement carefully,
and, if you agree to the terms,
check the "l agree" box and click "OK",

If you do not agree with the terms of the software licence
agreement, click "Cancel" and finish the installation.

Follow the instructions on the screen to complete the installaton
complete the installation.

When the installation is complete, you will receive a message that
the software has been successfully installed.

As soon as the installation is complete, you can start the
programme by double-clicking on the programme symbol.
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INSTALLATION

MAC OS

Installation instructions for MacOS

Please ensure that your Apple Mac meets the minimum hardware require-

ments!

Before starting the installation, please log on as administrator and close all

running applications if possible.

www.cura3D.com

Double click on "cura3Dmuseumpro_setup.exe".
The installation screen of the software will appear.

Read the software licence agreement carefully,

and, if you agree to the terms,

check the "l agree" box and click "OK".

If you do not agree with the terms of the software licence
agreement, click "Cancel" and finish the installation.

Follow the instructions on the screen to complete the installaton
complete the installation.

When the installation is complete, you will receive a message that
the software has been successfully installed.

As soon as the installation is complete, you can start the app by
double-clicking on the app icon.
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FIRST STEPS

START APPLICATION

Start the application by clicking on the icon "cura3D museum pro" on your
desktop or start the application from the programme menu under Win-
dows.

When the application has loaded, the first thing you will see is the start win-
dow @, which offers you the following options:

If we have been able to create several exhibition spaces / museums / galle-
ries / exhibition halls for you, select the desired architecture from the drop-

down menu.

Start your project by clicking on the "Start" button @.

www.cura3D.com

museum pro Cmﬂ

- Exhibition space

e Select building or exhibition space

Load showrooms and start application
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FIRST STEPS

LICENSE VALIDATION

When you start museum pro for the first time, the "Programme Info" win-
dow @ will open automatically and you will be asked to enter your licence
key @ to unlock the software.

You must be connected to the internet to do this.

If your computer is behind a so-called "proxy", you can make these settings
for the verification process yourself. The best way to do this is to contact
your administrator or IT representative. You can change the proxy informa-
tion in Settings -> Connection settings.

Your "ID" is unique to your computer. If you have chosen a single-user li-
cence (e.g. fairplanner pro), the licence key is linked to this ID and can only
be used with this computer.

The ID is irrelevant for the use of floating licences.

If you ever need a new licence key for your activated computer, you will al-

ways find it in the "Programme Info" window. You will always find this win-
dow on the "Toolbar" icon, see figure @.

www.cura3D.com

Programme information

cura3D museum pro 2023
(Montag, 1 Januar 0001 00:00)

Museum (Arch.-Mod.
Museum1_bk_def)

(3]

Update licence

Your computer ID

K+L1Gkd9234=70vzeass

Licer

Zkjndefgs3iz90362ds8asnbjklsa87

Opens license window

www.cura3D.com




FIRST STEPS

USER INTERFACE

The interface has been designed to help you find your way around quickly
and intuitively. The interface is divided into three main areas.

The header area contains the text-based "File Menu" and the "Toolbar" with
the most common programme actions.

The middle area is for planning interactions and is your workspace.
At the bottom of the application is the 'Gallery Bar".
This is where the imported exhibits are displayed and selected for place-

ment. Various filter and search options help you to find the desired exhibit
quickly, even in large exhibition projects.

www.cura3D.com

Colour wall

Wall dimensions

Wall development as PDF ——

Create screenshot

Create InteractiveTour VR ——

Place exhibits automatically ——

Quick import

'

Exhibits

L

Floor plan view 3D-view InteractiveTour VR
create
Last action Model view Create rooms
restore
Move forward
Move right

Viewing direction

Move backwards

Gallery bar content

Filter by media type

ition : Meine Austellung...*

Name of the exhibition currently open

L

Shift Rotate
Object / Exhibit Object / Exhibit

Move Object / exhibit Selection between
via 3D Gizmo Global or Local
coordinate system
(alignment of the pivot point)
Programme
information

Distances of the selected
Exhibit to walls & objects
(Depending on the centre
or the sides of the exhibit)

Go to the exhibit

Reduce gallery bar
Delete exhibition Gallery list view —|

www.cura3D.com




Bl FIRST STEPS

USER, SYSTEM AND DATABASE SETTINGS

Basic settings

These are the basic settings:

e Language selection (English, German, French, Suomi, Swedish)
e Measurement system selection (metric/imperial)

o Global centreline height

e Display quality

e Basic lighting settings (requires Plugln Lighting)

¢ Viewing angle - Field of View (FOV)

Connection Data

If you have purchased the plug-in to connect to your museum's database,
you will need to enter your credentials in the Database Connection section
to enable the import of exhibits and collections.

Please contact our support team for initial setup.

If you have purchased our InteractiveTour VR plug-in, you will have recei-
ved connection details from us that you must enter in the appropriate fields
in order to publish virtual tours on the Internet. The access data should al-
ready have been filled in during the software installation.

If you use a proxy server in your network infrastructure, ask your local ad-

ministrator for the connection details. Then check Use Proxy to use the
connection with the proxy server.

www.cura3D.com

English

Metrisch

Beautiful

125%

zetcom

¢9 GallerySystems

robotron”

(§) easydb.museum

axiell

AN
Databases

We support a wide range of established
databases in the museum and gallery sector.
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NAVIGATION

MOTION CONTROL

There are various ways to move through the exhibition spaces.
Motion Gizmo

Click the direction arrows @ with the left mouse button to move forwards,
backwards or sideways. If you keep the mouse button pressed, you will
move continuously in the selected direction.

To change the viewing angle in the room, click on the trackball with the left
mouse button. Hold down the mouse button and move the mouse in the

desired direction. Alternatively, you can change the viewing direction by
holding down the mouse wheel and moving the mouse.

Movement via keyboard

You can also use the keyboard to move around the room. To do this, use the
"WASD"® keys.

You can also hold down the Shift key to move around the room more quick-
ly.

www.cura3D.com

o Move forward

Move left Move right

/

Viewing direction

Move backwards

Motion control with the mouse only

Alternatively, you can use the mouse to move around the virtual room. To
move forward, scroll forward with the mouse wheel. To move backwards,
turn the wheel backwards.

Tip:
If you double-click on the floor with the left mouse button, you will
automatically move to that position.

(2]
Move forward
Move left Move right
AEE) )+
\ Move backwards Move forward faster
(3]
[ Leertaste ]
Tip:

Pressing the space bar @ will always align your view with the horizon
axis.

Mostly used as a selection tool

I

Scrollrad
(Klick = 3. Maustaste)

Used for extra options (secondary click)
or used for resetting / deleting

WWW.CUIf




NAVIGATION

EDITING VIEWS

Editing Views
The exhibition spaces can be viewed from different views.

The different views help you to place exhibits and position yourself in the
room as easily as possible.

You can change the view using the "View" menu @ or the "Toolbar" @.

Tip:
When you open the application, you always start in the 3D view.

www.cura3D.com

Floor plan view 3D view

Model view

«

Floor Plan View

The floor plan view is ideal for placing 3D exhibits in the room or quickly
moving to another room.

To change floors, click on the appropriate architectural overview icon in the
bottom left-hand corner.

Model View

The model view allows you to check the placement and impact of exhibits
from different perspectives and to quickly pre-position exhibits across mul-
tiple rooms.

You can rotate the model by holding down the scroll wheel and moving the
mouse. In this view you can also use the architectural overview icon to show
and hide the floors.

3D View

The 3D view is the default view and is used for interaction in the room and
with the exhibits. Images of works can be dragged and dropped onto the
walls or floor. This view helps you to evaluate the works in the virtual exhi-
bition space and to optimise hanging and placement.

Tip: In all three views, you can drag and drop to place and move exhibits.
From the floor plan and model views, you can return to the 3D view by
double-clicking on the floor.

=

(&3
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B EXHIBITS

IMPORT AND VIEW

Import

You can import all exhibits and exhibit lists using the "Import" menu @ at
the top of the screen or the "Quick Import" menu @ at the bottom left of
the screen in the "Gallery Bar" @.

Both menus allow you to import the following media formats and lists:

e Images 2D (BMP, JPG, PDF, TIFF, PNG)
¢ 3D objects (FBX, DAE, OBJ, GLTF)

e Pseudo 3D objects (PNG, JPG)

¢ Video (MP4, OGV)

e Exhibit lists in format XLS(X), CSV

Imported exhibits are first displayed in the Gallery Bar until they are placed
in the room (wall/floor).

Filter exhibits

To specifically search / filter the matching exhibits in the "Gallery Bar" @ af-

ter import, use the "Filter Menu" @. By clicking on the filter icon in the "Gal-

lery Bar" @ you can filter for the following metadata entries:

o Artist

o Title

e Object ID/Inventory Number (ID)
e Date

® Medium

e Commentary

www.cura3D.com

Gallery bar content

Filter by media type

All data fields can be enabled and searched at the same time. Imported files
can also be filtered by the following format criteria:
All / 2D / 3D / Pseudo3D / Video / Text

Placed exhibit

Exhibit list view

The list view provides a quick overview of both placed and unplaced exhi-
bits. You can access the list via the Exhibit List button 22 and also sort all ex-
hibits by title, artist, ID, wall and room name. Clicking on a work image

opens the Exhibit Manager.

Note: If you would like to export a clear list of your exhibits in-
cluding metadata for distribution, the file format XLS is available.
The export is done via the menu File / Export / Exhibit List.

www.cura3D.com




’ Please set the appropriate attributes for each table column in this drop-down menu,
so that the contents can be correctly assigned in museum pro.

EXHIBITS

IMPORTING EXHIBITS VIASPREADSHEETS

Table ( xIs/csv)

Import as Image file Artist v Dating

To comment YearOfPublication

Header ImageFront Artist

Data

cura®® museum pro offers the possibility to import exhibit data in XLS,
XLSX or CSV file format.

S Werkbamealn - LibeOMice Calc - o X

Drtigen foman Fomaniagen Dbele Owen Egvm Feer L &

Goie Bewbeten  in

The attached screenshot shows the structure of the sample file used for im- it s e o = : B8
port. The image (file) name associated with the exhibit entry must be speci- T B AL (o - - - — - Line1 Profile width vertical
. . K . " ! ¢ o E § g W ' nl= Assignment Profile width horizontal
fied. In addition, all associated image files must be located in one folder, i Filename | ID __Artist Title  Year Height Width Depth  Comment _State A
which you must select using 'Select image path' " e S g 5 o : — % Fromline2 Depth
y g g p * } lesipy (21 Justus Jager HARUES 46 = 4512 3 VrtMaricht @ Record
et on | s :D]Sm o Justs lages ELENAZY ) 4458 3 — 2 with frame
You can also use the text-based "File" menu @ at the top of the screen or .. T P . & - i N—
the "Quick Import" menu @ at the bottom left of the "Gallery Bar" €. Once e S s 4 e : s
1630 jpg. 630 Justus Jager CHERI 27 L3 0m 3 Verofermichi
the file has been successfully imported, all you need to do is assign the cor- * losin R » aa ) ——
rect attributes to the appropriate column in the table (see illustration). o SR R 5 i ; S
F ey o T Justus. Jager SIORHAN 1 ™ 073 3 Veroferticht
; i 1626 jpg (=1 Justs Jager SASKIA 36 ] %3 3 Vrtersicht
" s ipg s Justuss Jiger DEMIR o B 3 er——
| ® ltjpg G Jush fager PAOLA X 5 4006 3 Vesotarmicht
‘ 6 R ® an : Vet Tip: If your different tables have the same structure, you do not
s e e . - X == need to assign the metadata entries each time. Simply select T
ud G s g ANOREA 0 s : Vo 'Save as default profile'. The next time you import, all you need
; ::ﬁ :: j:: j: :::E“ ": :: ’ ‘:::: todois Change the image path Click on "Select image path ." to specify the location of your exhibits to be imported.
+  Wekbie i
Tabelle 1von 1 Pagelite_Weridnte Denitich (Deutschland) 1@ Mimebwert: - Summe O = - + — 4+ | 10%

www.cura3D.com www.cura3D.com




EXHIBITS

PLACEMENT

To place an exhibit on a wall or floor, go to the 3D or Model view and drag
the exhibit from the gallery bar to the desired location while holding down
the left mouse button. Click and hold the left mouse button on the exhibit to
move it to the desired position.

3D View

Tip: If an exhibit cannot be placed where you want it, please check the
dimensions of the exhibit. Simply double-click on the work in the gallery
bar to open the detailed view.

Under the 'Exhibit' tab, you can change the dimensions if necessary.
This is particularly important for different 3D objects, as different coor-

dinate systems and units of measurement can lead to errors, depending
on the software used to create them.

www.cura3D.com
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EXHIBITS

EXTENDED OBJECT PLACEMENT

www.cura3D.com

When placing 2D or 3D exhibits, the 4@ Move object tool is selected by de-
fault. In this mode, you can easily move objects in the room using drag-and-
drop, which automatically snap into place on walls, floors and ceilings.

For more precise positioning of the objects in the room, we recommend the
fg’ 3D gizmo, which allows you to move your selected object steplessly in all
axes. To do this, click and drag on one of the coloured arrows displayed in
the centre of your object and move the object along the corresponding axis.
This mode also allows you to move objects through glass surfaces and walls
and to place objects floating in space.

With the <6.> rotation tool, you can quickly and easily rotate the object in the
corresponding axis by clicking and dragging the coloured rings. This tool
works closely with the quick positioning tool. Settings that you make here
are also displayed using numerical values in the quick positioning tool..

Rotate

| =

3D View Shift

Object / Exhibit Object / Exhibit
Move Object / exhibit Selection between
via 3D Gizmo Global or Local

coordinate system
(alignment of the pivot point)

Local

ey

\ ,-\r—'

PR 2 A

Global

Sometimes it is useful to switch from a @ globaltoa @ local coordinate system, especially for objects hanging on
walls. These two buttons are used to realign the pivot point of your 3D or 2D object.

www.cura3D.com




EXHIBITS

QUICK POSITIONING TOOL

Left-click on an exhibit to open the Quick Positioning tool. This tool allows
you to precisely position exhibits and gives you advanced setting options.

The dimensions in the input boxes indicate the distance of the exhibit from
the outer edges of the wall or floor/skirting. Change the values here to af-
fect the positioning. In the centre of the screenis a 'grid' box with a total of
10 measurement points. These can be used to easily align an exhibit, taking
into account the height of the top, middle or bottom edge.

Clicking on the <9> symbol will take you directly to the selected exhibit, with
the current distance to the exhibit displayed next to it. If you wish to use im-
ported image files as wallpaper, click on the 'Create wallpaper' button.

Achtung:You will then no longer be able to select this image with a left click.
To edit or remove the background image, switch to the Colour Wall dialogue
box (see secondary menu on page 43).Selected 2D objects can be rotated
around one axis, (pseudo) 3D objects around two axes.

To rotate the selected exhibit, move the corresponding slider to the right or
enter a numeric value (in degrees) in the adjacent text box.

www.cura3D.com

Distances of the selected
Exhibit to walls & objects
(Depending on the selected pivot point)

Dimension units —_|

Go to exhibit _| [

Rotation settings
for 2D exhibits

File name for 3D objects

When the button is activated,

the exhibit automatically rotates towards

the viewer to simulate spatiality

(this option is available only for pseudo-3D objects)

Rotation settings
for 3D exhibits and Psyeudo 3D objects

Distance of the exhibit to the wall or floor

Exhibit-1D

Distance to the exhibit in the room, starting from
your current position in the building.

This button allows you to convert a 2D exhibit into a

wallpaper. This fixes the visual to the wall and you
can now place place exhibits in this area.

3D Exhibits
&
Psyeudo 3D Objects

The blue marking indicates that this object is currently se-
lected. Deselect by left-clicking on another object, the floor,
ceiling or wall of the room.

3D View

Tip:
Click on your placed object while holding down the Ctrl key to rotate it.
This works for 2D and (pseudo) 3D exhibits in all editing views.

2D

www.cura3D.com




EXHIBITS

EXHIBIT MANAGER / METADATA
Exhibit

Under the Exhibit tab you will find all the relevant data for the selected
work; this metadata is optionally matched and imported from an existing
database or from a table in csv or xIs format.

You can edit the fields or add additional information at any time.

Tip:
If an exhibit (2D / 3D) is too large, it cannot be placed properly. In this
case, the dimensions must be adjusted manually.

Three individually
usable text fields

Adouble click
on an exhibit
opens the
Exhibits view

www.cura3D.com
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EXHIBITS

EXHIBIT MANAGER / PASSEPARTOUT

www.cura3D.com

Checkbox with a tick

activates the passe-partout

With a click on the "+" plus symbol you can
save your currently set color.

Passepartout

Tick the Passepartout box and enter the desired dimensions. Use the lock
icon (selected by default) to link the horizontal and vertical dimension ent-
ries.

If you want to enter different dimension values, click the lock icon. Next, se-
lect the desired colour in the colour dialogue box. Use the RGB colour set-
tings, pick a colour from an image element with the eyedropper, or enter the
HEX colour value.

Under "Last used colours" you can save up to 8 colours by clicking the "+"
button and use them in all colour dialogs.

www.cura3D.com




EXHIBITS

EXHIBIT MANAGER / FRAMES

www.cura3D.com

Ticked checkbox
activates the frame

Frames

Select the 'Frame' check box.

Enter the profile width of the frame and note that the horizontal and verti-
cal profile width lock icons are enabled by default (in the rare event that the
horizontal and vertical profile widths are different, click to disable).

Nutzen Sie den ersten Rahmentypen, um eigene Farben zu verwenden, an-
sonsten steht Ihnen eine Auswahl an unterschiedlichen Rahmentypen zur
Verfligung.

Caution:
Selecting a frame from the library may override your colour settings, but
will not affect the profile width.

www.cura3D.com




B EXHIBITS

3D EXHIBITS AND DISPLAY CASES

3D Models

Ansicht der gewahlten
Vitrinen-Oberflache,
hier kénnen Exponate
platziert werden.

Display Cases

Use the mouse wheel to

museum pro can import a variety of common 3D file formats. To import 3D data, you can also use the "File menu" @ Zoomin or out on the 3D object

Configurable and playable showcases are 3D objects created by cura3D
especially for museum pro. Exhibits can be placed on the predefined

zoom out

or the "Quick import menu" @.

In the left section of the image the view

fter selecting the file in the File Manager, the 3D models are loaded into the Gallery Bar ©.
Double-click on the 3D object in the gallery bar to open the exhibit view.
Here you can edit metadata, check or change dimensions.

www.cura3D.com

of the 3D model by holding down the shelves.

Tip: If a 3D object cannot be placed in space, check the dimensions of
the object.

In the 3D view, you can now examine your placed exhibit
inside the showcase. Double click on the
display case to edit its contents.

www.cura3D.com



TOOLS

SECONDARY MENU

The secondary menu summarizes the most important project-related ope-
rations in a compact menu.

Wall Colouring

Right click on a wall, floor or ceiling and select the T symbol. The Wall Pro-
perties dialogue box opens, allowing you to colour the selected element.

Wall Dimension

This tool only works on walls and temporary architecture. First place at le-
ast one exhibit on a wall, then right-click on the wall. Select the mm symbol
to display the dimensions.

Wall Development as PDF

To get a PDF document with all dimensions, right-click on the desired wall
and select the P4f symbol.

Note: At least one exhibit should be placed on the wall to create a meaning-
ful wall development.

www.cura3D.com

Create Screenshot

First align your view in the 3D or model view, then right-click on the floor,
wall or ceiling and select the Screenshot icon. This will save the selected
perspective in double resolution and without the GUI. The Windows Explo-
rer / Mac Finder will open and you can choose where to save the file.

InteractiveTour VR

This menu item 22 allows you to create virtual tours of your exhibitions.
You will need the InteractiveTour VR plugin to do this, see the correspon-
ding section for more information.

Automatically place exhibits

Select the E'E,EI symbol from the right-click menu to automatically place exhi-
bits on a wall. Before placing, you can set the minimum distance between
each exhibit.

This feature is particularly effective when used in conjunction with filtering.
For example, you can search for an artist in your exhibits and pre-position
them on the wall of your choice.

3D View

Wall Colouring

Wall Dimension

Wall Development as PDF ——

Create Screenshot
Create InteractiveTour VR ——

Automatically Place Exhibits

'N
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P TOOLS

SECONDARY MENU/WALL COLOURING

3D View

Wall information

The Wall Properties window not only allows you to change the appearance

of awall, floor or ceiling, but also to create and change wall names. Right- e waigapes 1| ——— o ersion ot wallpaper
click on awall, ceiling or floor and select theT symbol to open the dialogue
box. |

RGB color system with alpha channel - Wall Colouring
(only possible for certain elements)

Named walls have the advantage of making it quicker and easier to assign
and locate exhibits in the architecture.

In addition, this dialogue can be used to convert wallpapers back to exhibit
images for use as exhibits.

For temporary architecture, you can also use the alpha value (A) to make in-
dividual sides of the wall transparent.

The pipette ’ allows you to quickly select a colour from anywhere on the
screen. For example, select the colour in an exhibit to use it as a wall back-
ground colour.

Once you have selected the colour or colour value, press Apply to confirm.

Save a colour pre-selection by clicking on the "+" in the "Last used colours"
box, and you can save up to 8 colours for further editing in the quick selecti-
on.

Example of temporary architecture with applied
alpha transparency to simulate glass surfaces.

www.cura3D.com www.cura3D.com




TOOLS

SECONDARY MENU / WALL DIMENSION
AND WALL DEVELOPMENT AS PDF

Wall Dimension

Once you have placed exhibits on a wall, you can right-click and select Dy-
namic Wall Measurements to display the distances of the exhibits to each
other, to the outer edges of the wall and to the floor. You can also view and
change the centreline height of the exhibits in the Quick Positioning tool.

The dimensioning is calculated dynamically, i.e. you can move and reposition
exhibits as the dimensioning always adjusts.

To hide the dimensioning again and exit the dimensioning tool, right-click on
awall.

www.cura3D.com

Wall Dimension

—— Wall Development as PDF

Wall Development as PDF

Output the wall history as a PDF file.

To do this, right-click on the desired wall and select the P4f symbol from the
pop-up menu. Once the document has been successfully created, your PDF
program will automatically open for viewing.

le of PDF document with wall d
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TOOLS

WALLPAPER

Import an image file or use a previously imported exhibit.

Locate the appropriate image in the Gallery Bar and double-click to resize
the image. In the 'Exhibit’' tab, enter the appropriate height and width and
click the 'Apply' button at the bottom right of the window. Once you have
adjusted the settings, you can drag the image from the Gallery Bar to the
desired wall.

Now position the image and click the 'Create Wallpaper' button in the
'Quick Positioning Tool..

To convert a wallpaper back to a normal image, right-click on the correspon-
ding wall and select the Wall Colour T symbol from the pop-up menu. Once
the wall properties window has opened, simply click on the 'Remove Wall-
paper' button and the wallpaper will be converted back to a normal image
and returned to the 'Gallery Bar".

www.cura3D.com
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TOOLS

CREATE TEXT

cura®® museum pro makes it possible to create texts using an internal text
editor. The texts can be edited at any time, even after they have been placed
in the exhibition rooms, by double-clicking on the text.

The text editor can be found in the ‘File menu’ @ or in the ‘Quick import
menu’ @ at the bottom left of the ‘Gallery bar’ @.

Just like exhibits, the created text elements are initially located in the ‘Gal-
lery bar’ @ and must first be dragged and dropped onto the walls. Once the
created text element has been placed on the wall from the gallery bar, you
can start editing by double-clicking on the text.

Move the text while holding down the mouse button and adjust the text box
format using the blue frame. The editing of the text corresponds to that of
standard word processing programmes. Select individual letters or entire
words to adjust font styles.

To exit the editing mode, press the Esc key on your keyboard.
For typographically complex texts, please use common editors such as
Adobe® InDesign or Affnity® Publisher and export them in PNG format

with layer transparency. The imported texts behave like images that can be
scaled.

www.cura3D.com

Lato-Regular

Font type

Fontsize

Import

Bold Italic

Underline

Crossed out

Lowered

Text color

Subscript

Text alignment
(left, centre, right)

Text spacing

e

E

orem ipsum dolor sit
met, consectetuer
dipiscing efit. Aenean

commodo ligula eget

oior]
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TOOLS

TEMPORARY ARCHITECTURE

Temporary architecture allows you to create pedestals, plinths, columns
and freestanding walls on which you can later hang exhibits, add text and
colour.

To create temporary architecture, use the File menu @ or the Quick Import
menu @ again and select the appropriate menu item.

In the editor that opens, you will see the floor plan of the building, navigate
to the desired room by holding down the third mouse button (scroll wheel)
and double-click on the desired location where you want to create a base,
for example. Then edit the dimensions of your temporary architecture.

Hold down the left mouse button to reposition the base in space, use the di-
stance grid to move the object only at certain distances.

To delete temporary architecture, right-click on the relevant architectural

element. Note that there must be no exhibits on the wall/plinth to be
deleted.

www.cura3D.com

o

\

49 m

Example of how to

use the baseboard
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PLUG-IN

InteractiveTour

With our InteractiveTour VR plug-in for museum pro and gallery pro, you
can easily publish exhibitions as virtual tours with any number of view-
points.

Once the tour has been published, an embedding link is automatically crea-
ted, allowing you to embed your virtual tour in all popular content manage-
ment systems such as WordPress, Joomla, Drupal, etc.

To create a tour, click on the 2% symbol, use the secondary menu or select
Export -> 360 degree tour.

This will open the virtual tour administration interface. Navigate to the
desired starting point of your tour and click 'Add Viewpoint' Navigate
through the exhibition in the order you wish and add more viewpoints.
Viewpoints can also be added in the floor plan view. The order of the view-
points can also be changed later using the arrows. The viewpoints can also
be named using the text box. By editing the X and Y coordinates (same valu-
es) you can fine-tune the viewpoints and ensure they are exactly on an axis.

Finally, click on the "Publish tour" button and select the desired resolution
(recommended: 8192 x 4096 pixels for workstations, 16192 x 8192 pixels
for publications). Processing and rendering of the virtual tour will now be-
gin and may take some time (depending on the size of the tour / number of

viewpoints, 10 viewpoints in high resolution will take approx. 2 - 5 minutes).

www.cura3D.com

create InteractiveTour VR

Creating panorama tour

Start of publication

Name of the position (optional)

Delete individual viewpoint

Change position order

Close window
(current settings

are not lost)

Delete all positions

Then choose a unique name for your tour.
Please note: Tours with the same name will be overwritten without
warning.

After a successful upload, your browser will open and you can take a web-
based tour of your virtual exhibition. In museum pro, the embedding link is
displayed and can be copied to the clipboard.

Assign a name for the tour

Uploading files._.

Creating panorama tour

L Set Viewpoint

Note: The metadata previously imported into our planning software will
be retained and can be viewed by clicking on the exhibit. Further entries
can be added in the admin area of the virtual tour. Each front-end secti-

on (index.html) has a corresponding back-end section that can be acces-
sed via indexAdmin.html.
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PLUG-IN

GROUNDSKETCHER

Click on the symbol ¥ in the toolbar to start drawing new rooms. You can
now first load a floor plan as a PDF or JPG file into the background of the
drawing area. This will allow you to draw the floor plan of the room quickly
and easily. The floor plan is not essential, but it makes it easier to transfer
the dimensions to scale. Click on the drawing area at the desired starting
point to create the first anchor point.

To ensure that the wall surfaces are at right angles, you can select the corre-
sponding angle of 90° in the Angle grid menu. Similarly, you can create wall
segments with predefined dimensions (50 cm, 100 cm, etc.) using the "Spa-
cing grid" menu item.

When you have finished drawing your room, you need to connect the first
anchor point to the last anchor point. To do this, click on the 'Connect
points' button. This completes the creation of the room. You can then make
other settings, such as selecting the floor covering and setting the room
height.

Click on 'Apply' to exit floor plan mode and return to the 3D view of your
newly created room.

www.cura3D.com

Create room

Afloor plan as a template
Load in the background

Déarance snsppisg:

Angle snapping.

Room name
(optional)

Distance snapping:
 OFff
10cm
50cm

100cm

Angle snapping:
v Off
15°
45°
90°

Flooring 1

+~/ Flooring 1

EETE
u ETE ®
[ siim ]
[ ] b as7m |

1.57m

Set wall type

v Wall 1{0Ocm >

Wall 2{0Ocm » @

Wall 3(0cm »

Wall 4(0cm>

Partial deletion

Delete the entire architecture or
partial deletion (see selection).

Close window
(current settings

are not lost)

Create room
confirm
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